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Definition of Shareware

Shareware distribution gives users a chance to try software before buying it. If you try a 
Shareware program and continue using it, you are expected to register. Individual programs 
differ on details -- some request registration while others require it, some specify a 
maximum trial period. With registration, you get anything from the simple right to continue 
using the software to an updated program with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder 
retains all rights, with a few specific exceptions as stated below. Shareware authors are 
accomplished programmers, just like commercial authors, and the programs are of 
comparable quality. (In both cases, there are good programs and bad ones!) The main 
difference is in the method of distribution. The author specifically grants the right to copy 
and distribute the software, either to all and sundry or to a specific group. For example, 
some authors require written permission before a commercial disk vendor may copy their 
Shareware.

Shareware is a distribution method, not a type of software. You should find software that 
suits your needs and pocketbook, whether it's commercial or Shareware. The Shareware 
system makes fitting your needs easier, because you can try before you buy.    And because 
the overhead is low, prices are low also. Shareware has the ultimate money-back guarantee 
-- if you don't use the product, you don't pay for it.



Software Product License Agreement

This software program ("SOFTWARE") is copyright (c) 1996 by Excellco, Inc.    All rights 
reserved.

All SOFTWARE including any subsequent updates is furnished under the following license 
terms and conditions:

THIS IS A SINGLE COPY SOFTWARE LICENSE granted by Excellco, Inc. 1960 Eva Drive, 
Lansdale, Pennsylvania 19446.    The SOFTWARE in this package is licensed to you.    It is not 
sold.

LICENSE:
The SOFTWARE enclosed in this package is copyrighted material.    Once you have paid the 
required single copy license fee, you may use the SOFTWARE for as long as you like provided
you do not violate the copyright and you follow the rules described below.

You may use the SOFTWARE on any computer for which it is designed so long as no more 
than one person uses it at any one time.    You must pay for additional copies of the 
SOFTWARE if more than one person will be using it at the same time on one or more 
computers.

You may make as many copies of the Licensed SOFTWARE as you wish for backup purposes 
and all such copies, along with the original, must be kept in your possession or control.

You may not make any changes or modifications to the Licensed SOFTWARE. You may not 
decompile, disassemble, or otherwise reverse engineer the SOFTWARE.    You may not rent or
lease it to others.    You may not use it on a computer network unless only one person can 
use it at a time.

LIMITED WARRANTY:
The Customer assumes all responsibility for the selection of the SOFTWARE as appropriate to
achieve the results intended by the Customer.    Excellco, Inc. warrants that any magnetic 
medium that it has shipped which the SOFTWARE is recorded on and any Documentation 
provided with it are free from defects in materials and workmanship under normal use.    
Excellco, Inc. warrants that the SOFTWARE itself will perform substantially in accordance 
with the specifications set forth in the Online Documentation provided with it.

The above express warranties are made for a period of sixty (60) days from the date the 
SOFTWARE is delivered to you as the first user.

Obligations of Excellco, Inc. during the warranty period:
Excellco, Inc. will replace any magnetic media which it has provided which proves defective 
in materials or workmanship, without additional charge, on an exchange basis.    In the case 
of errors in the Online Documentation, Excellco, Inc. will correct the errors in the 
Documentation and at its discretion provide new Online Documentation at no charge.

Excellco, Inc. will either replace or repair without additional charge any SOFTWARE that does
not perform in substantial accordance with the specifications of the Online Documentation.    
This will be done by delivering to you a corrected copy of the SOFTWARE or corrective code, 
on an exchange basis.



If Excellco, Inc. is unable to replace defective media or if Excellco, Inc. is unable to provide a 
corrected copy of the SOFTWARE within a reasonable time, Excellco, Inc. will either replace 
the SOFTWARE with a functionally similar program or refund the license fees paid for the use
of the SOFTWARE.

Exclusion of other warranties:
Excellco, Inc. does not warrant that the functions contained in the SOFTWARE will meet your 
requirements or that the operation of the SOFTWARE will be uninterrupted or error free.    
The warranty does not cover any media or documentation which has been subjected to 
damage or abuse by you.    The SOFTWARE Warranty does not cover any copy of the 
SOFTWARE which has been altered or changed in any way by you or others.    Excellco, Inc. is
not responsible for problems caused by changes in the operating characteristics of the 
computer hardware or operating system which are made after the delivery of the 
SOFTWARE.

EXCEPT FOR THE FOREGOING LIMITED WARRANTY, THE SOFTWARE IS PROVIDED "AS IS" 
WITHOUT WARRANTY OF ANY KIND EITHER EXPRESSED OR IMPLIED, INCLUDING, BUT NOT 
LIMITED TO THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A 
PARTICULAR PURPOSE.

IN NO EVENT WILL EXCELLCO, INC. OR ITS SUPPLIERS BE LIABLE TO YOU FOR ANY DAMAGES 
WHATSOEVER, INCLUDING, WITHOUT LIMITATION, ANY LOSS OF PROFITS, LOST SAVINGS, 
BUSINESS INTERRUPTION, LOSS OF BUSINESS INFORMATION, OR OTHER INCIDENTAL OR 
CONSEQUENTIAL DAMAGES ARISING OUT OF YOUR USE OF OR INABILITY TO USE THE 
SOFTWARE, EVEN IF EXCELLCO, INC. OR ITS AGENT HAS BEEN ADVISED OF THE POSSIBILITY 
OF SUCH DAMAGES.    Some states do not allow the exclusion or limitation of incidental or 
consequential damages, so the above limitations or exclusion my not apply to you.

Your obligations under the warranties:
You must call Excellco, Inc. for an authorization to return any defective item to Excellco, Inc.,
during the warranty period.    If Excellco, Inc. is unable to correct your problem by telephone, 
you will be provided with a return authorization number and an address for returning the 
defective item for warranty service or replacement.    You must insure any defective item 
being returned because Excellco, Inc. does not assume the risk of loss or damage while in 
transit.

Other conditions:
The warranties set forth above are in lieu of all other express and implied warranties, 
whether oral, written, or implied, and the remedies set forth above are your sole and 
exclusive remedies.    Only an authorized officer of Excellco, Inc. may make modifications to 
this warranty, or additional warranties binding on Excellco, Inc..    Accordingly, additional 
statements such as advertising or presentations, whether oral or written, do not constitute 
warranties by Excellco, Inc. and should not be relied upon as such.    This warranty gives you 
specific legal rights, and you may also have other rights which vary from state to state.

LIMITATIONS OF LIABILITY:
In no case shall Excellco, Inc. liability exceed the license fees paid for the right to use the 
Licensed SOFTWARE or one hundred fifty dollars ($150.00), whichever is less.

INTEGRATION:
This License constitutes the entire agreement and understanding between the parties and 
supersedes any prior agreement or understanding whether oral or written, relating to the 



subject of this License.    This Agreement may only be modified by a written agreement 
signed by Excellco, Inc.

GENERAL:
If any provision of this Agreement shall be unlawful, void or for any reason unenforceable, 
then that provision shall be deemed severable from this Agreement and shall not affect the 
validity and enforceability of the remaining provisions of the Agreement.

You are encouraged to pass a copy of the SOFTWARE along to your friends for evaluation.    
Please encourage them to register their copy if they find that they can use it.    All registered 
users will receive a copy of the latest version of the the SOFTWARE system.



Order Information

Registering the Text Search program licenses you to use the product on a regular basis, see 
the Software Product License Agreement.    Registration includes the current version of the 
program, mailed notification of updates, special pricing on updates, and priority support.

Individual registrations for the Text Search program costs $20.00.    For registrations of more 
than 10, please call.

Please use the enclosed Order Form when placing an order by mail.    You can also call us at 
(215) 699-4021.    We accept checks, Visa and MasterCard.

To print the order form:
display the order form on the screen
Select File from the menu
Select print topic

ORDERS OUTSIDE THE US: Please send checks drawn on US banks in US
dollars.



Order Form

Excellco, Inc.
1960 Eva Drive
Lansdale, PA    19446

PAYMENT (CIRCLE ONE): VISA M/C Check

Card Number: _______________________________________

Expiration Date:_____/_____

Signature: ___________________________________________

Name: _____________________________

Company: __________________________

Address: ___________________________

City: _______________________________

State: _____ ZIP Code: ______________

Country: _______________

Text Search:
Copies _______    x    $20.00 ______

Shipping:
Copies _______    x    $1.00 _______

PA residents please add
6% sales tax _______

TOTAL _______

ORDERS OUTSIDE THE US:      Send check drawn on US bank in US dollars.



Introduction
This is a shareware program, it is not free.    You may use it for a period of 30 days to 
determine if it meets your needs.    If, after that time you wish to continue to use it, you must
pay for the program, see Order Information.

This program searches a list of files (including a subdirectory search) for one or more text 
patterns (or phrases). It is capable of searching for text in any file including such files as .exe
and data files. The file name of each file that is searched is displayed (this may be 
suppressed so that only file names where the text is found are displayed).    If there are 
matches to the pattern (or phrase), the line number and the line containing the match are 
displayed.    Optionally, up to 10 lines before and 10 lines after the line containing the match 
may be displayed.    Also, up to five text patterns (or phrases) may be specified.

The first time the program is started, the following initial conditions are set:
    The program will not search sub-directories.�
    The program will not match the case of the text pattern.�
    All files searched will be shown.�
    Only the line containing the found text pattern will be displayed.�
    No lines before or after the line with the found text pattern will be displayed.�

This program remembers the last five text patterns, the last five file name or specifications, 
and the last five directories searched.    It will also remember each of the options selected.

This program can be setup to look for another program that is running and use it to obtain 
its search directories in the following manner:

Use the Search Setup dialog box to specify the other program's name from the title 
bar of the other program's main window.

When the Search for text dialog box is displayed, the other program name is 
searched for and if any of its child windows have a complete path name as their title, 
that path name is added to the list of search directories.

See the Search for text dialog box for a more complete description of the searching process.

See More Information to get in touch with Excellco, Inc.
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New Search

Use this command to start a new search in a new window.

Shortcuts

Toolbar:
Keys: CTRL+N



Open

Use this command to open an existing file containing the results of a previous search using 
the File Open Dialog Box .

You can create new search with the New Search    command.

Shortcuts

Toolbar:
Keys: CTRL+O



File Open Dialog Box

The following options allow you to specify which file to open:
File Name

Type or select the filename you want to open.    This box lists files with the extension you 
select in the List Files of Type box. 

List Files of Type
Select the type of file you want to open:

Drives
Select the drive in which the file is stored that you want to open. 

Directories
Select the directory in which the file is stored that you want to open.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 



Close

Use this command to close the top window containing search results.

If the search results have not saved, or have been modified, your are asked if you want to 
save the search results before you close window.    If you answer "Yes" to save the search 
results, one of the following will take place.

If the search results window has previously been saved (i.e. has been given a file 
name), the search results will be saved to that file.

If the search results window has not been previously saved (i.e. hasn't been given a 
file name), the File Save As Dialog Box will be displayed so you can name the file.

If you answer "No" and close a window without saving the search results , you lose them.

If you answer "Cancel", the window will not be closed.



Close All

Use this command to close all the windows containing search results.    This command uses 
the Close command for each open window.



File Save As Dialog Box

The following options allow you to specify the name and location of the search results you're 
about to save:
File Name

Type a new filename to save the search results file with a different name.    A filename 
can contain up to eight characters and an extension of up to three characters.

Drives
Select the drive in which you want to store the search results file or the test output.

Directories
Select the directory in which you want to store the search results file or the test output.

Network...
Choose this button to connect to a network location, assigning it a new drive letter. 

If you select a file that already exists, you will be prompted to find out if saving the search 
results to this file should continue.



Save

Use this command to save the search results in the top window to its current name and 
directory.

When you save the search results in a window for the first time, the File Save As Dialog Box 
is displayed so you can name the search results file.

If you want to change the name and directory of an existing file before you save it, choose 
the Save As    command.

Shortcuts

Toolbar:
Keys: CTRL+S



Save As

Use this command to save and name the search results in the top window using the File 
Save As Dialog Box 

This command will save the search results in the top window.

To save a search results window with its existing name and directory, use the Save 
command.



Save All

Use this command to save the search results in each window to its current name and 
directory..    This command uses the Save    command for each open window.



Print

Use this command to print the search results.    This command presents a Print Dialog Box, 
where you may specify the number of copies, the destination printer, and other printer setup
options.

Shortcuts

Toolbar:
Keys: CTRL+P



Print Dialog Box

The following options allow you to specify how the search results should be printed:
Printer

This is the active printer and printer connection.    Choose the Setup option to change 
the printer and printer connection.

Setup
Displays aPrint Setup Dialog Box, so    you can select a printer and printer connection.

Print Range
Print all the search results

Copies
Specify the number of copies you want to print for the above page range.

Collate Copies
Prints copies in page number order, instead of separated multiple copies of each 
page.

Print Quality
Select the quality of the printing.    Generally, lower quality printing takes less time to 
produce.



Print Setup

Use this command to select a printer and a printer connection.    This command presents 
aPrint Setup Dialog Box, where you specify the printer and its connection.



Print Setup Dialog Box

The following options allow you to select the destination printer and its connection.
Printer

Select the printer you want to use.    Choose the Default Printer; or choose the Specific 
Printer option and select one of the current installed printers shown in the box.    You 
install printers and configure ports using the Windows Control Panel. 

Orientation
Choose Portrait or Landscape.

Paper Size
Select the size of paper that the test output is to be printed on.

Paper Source
Some printers offer multiple trays for different paper sources.    Specify the tray here.

Options
Displays a dialog box where you can make additional choices about printing, specific to 
the type of printer you have selected.

Network...
Choose this button to connect to a network location, assigning it a new drive letter.



Recent File

Use the numbers and filenames listed at the bottom of the File menu to open the last four 
files you closed.    Choose the number that corresponds with the file you want to open.    You 
can also click on the file you want to open.



Exit

Use this command to end Text Search program.    You can also use the Close command on 
the application Control menu.    You will be prompted to save each search results window 
that has not been saved or has been modified and not saved.

Shortcuts
Mouse: Double-click the application's Control menu button.

Keys: ALT+F4
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Undo

Use this command to reverse the last editing action, if possible.      The name of the 
command changes, depending on what the last action was.    The Undo command changes to
Can't Undo on the menu if you cannot reverse your last action.

Shortcuts
Keys: CTRL+Z or

ALT-BACKSPACE



Cut

Use this command to remove the currently selected data from the search results window 
and put it on the clipboard.    This command is unavailable if there is no data currently 
selected.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+X



Copy

Use this command to copy selected data onto the clipboard.    This command is unavailable if
there is no data currently selected.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:
Keys: CTRL+C



Paste

Use this command to insert a copy of the clipboard contents at the insertion point.    This 
command is unavailable if the clipboard is empty.

Shortcuts

Toolbar:
Keys: CTRL+V
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Toolbar 
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Toolbar

Use this command to display and hide the Toolbar, which includes buttons for some of the 
most common commands in Text Search program, such as Open Test File.    A check mark 
appears next to the menu item when the Toolbar is displayed.

See Using Toolbar for help on using the toolbar.



Using Toolbar

The toolbar is displayed across the top of the application window, below the menu bar.    The 
toolbar provides quick mouse access to many tools used in Text Search program.

To hide or display the Toolbar, choose Toolbar from the View menu (ALT, V, T).

Click To

Start a new search window using the New Search    command.

Open an existing file.    The File Open Dialog Box is displayed, in which you can 
locate and open the desired test.

Save the search results in the top window with its current name.    If you have not 
given a file name to the search results, the File Save As Dialog Box is displayed.

Copy the marked text to the clipboard using the Copy    command.

Print the search results in the top window using the Print Dialog Box.

Displays the help contents.

This is the context help.    See the Context Help Command for a further 
explanation.

Enter text to search for and other search criteria using the Search for text dialog 
box.

Stop the search.



Status bar

Use this command to display and hide the Status Bar, which describes the action to be 
executed by the selected menu item or depressed toolbar button, and keyboard latch state. 
A check mark appears next to the menu item when the Status Bar is displayed.

See Using Status Bar    for help on using the status bar.



Using Status Bar

The status bar is displayed at the bottom of the program window.    To display or hide the 
status bar, use the Status Bar command in the View menu.

The left area of the status bar describes actions of menu items as you use the arrow keys to 
navigate through menus.    This area similarly shows messages that describe the actions of 
toolbar buttons as you depress them, before releasing them.    If after viewing the description
of the toolbar button command you wish not to execute the command, then release the 
mouse button while the pointer is off the toolbar button.

The right areas of the status bar indicate which of the following keys are latched down:

Indicator Description
CAP The Caps Lock key is latched down.
NUM The Num Lock key is latched down.
SCRL The Scroll Lock key is latched down.



Search

Search for text

Stop Search 
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Search for text

Use this command to search for text using the Search for text dialog box .



Search for text dialog box

The following dialog box is displayed to enter parameters for the text search.    You can find 
out more information about each item enclosed in a rectangle of dashed lines by clicking 
with the mouse inside the rectangle.



Text to search for

Enter the first text pattern the program is to search for (search pattern).

The last five text patterns entered here are remembered.    If there are five and you enter 
one more, the oldest one (the one at the bottom of the list) is dropped.

Enter a text string to search for.    Any alphanumeric character is allowed including spaces.    
The following characters are special.    Also you may selected one from the list.

A question mark (?) placed in the phrase matches any single character.

An asterisk (*) placed in the phrase matches any number of characters until a character is 
encountered which matches the character after the asterisk or until the end of the line is 
encountered.

A backslash (\) placed directly in front of a question mark or asterisk cancels their special 
meaning



List files to search

The last five files entered here are remembered.    If there are five and you enter one more, 
the oldest one (the one at the bottom of the list) is dropped.

Enter any valid file name or specification.    Also you may select one from the list.



Select directory to search

The last five directories entered here are remembered.    If there are five and you enter one 
more, the oldest one (the one at the bottom of the list) is dropped.

Enter any valid path or directory name.    Also you may select one from the list.



Search sub-directories

Check this box if you want to search all subdirectories of the search directory.



Match case

Check this box if you want to the search to be case sensitive (i.e. the case of the characters 
in the text pattern will be matched exactly).



Options

Click on this button to display the Options dialog box which allows you to enter additional 
text patterns to search for, allows you to specifiy a window around the found text, and other 
options.



Browse

Click on this button to display the Select Directory dialog box which allows you to select 
other drives and directories to search.



Stop Search

Use this command to stop the search.



Setup

Use this command to set parameters for the search program using the Search Setup dialog 
box .



Search Setup dialog box

The following dialog box is displayed to setup (configure) the text search program.    You can 
find out more information about each item enclosed in a rectangle of dashed lines by 
clicking with the mouse inside the rectangle.



Application Window Name

Enter the name of the application you wish the text search program to look for.    The name 
is the text to the left of the dash in the title bar of the main window.



Ask to Save Text in Window

If this box is checked, the text search program will automatically prompt to ask if the text in 
the currently active window should be saved when the window is closed.    This prompt will 
occur if the text has not yet been saved or has been saved and subsequently modified.

If this box is not checked, the text search program will not prompt to ask if the text should 
be saved when the window is closed.    It is up to the user to make sure the text is saved 
before closing the window.



Options dialog box

The following dialog box is displayed to enter parameters for the text search.    You can find 
out more information about each item enclosed in a rectangle of dashed lines by clicking 
with the mouse inside the rectangle.



Additional Text

This allows you to enter up to 4 additional text patterns to search for (search patterns).    All 
search patterns are searched for on each line of text from a file using the search conditions.

The last five text patterns entered for each search pattern are remembered.    If there are 
five and you enter one more, the oldest one (the one at the bottom of the list) is dropped.

Enter a text string to search for.    Any alphanumeric character is allowed including spaces.    
The following characters are special.    Also you may selected one from the list.

A question mark (?) placed in the phrase matches any single character.

An asterisk (*) placed in the phrase matches any number of characters until a character is 
encountered which matches the character after the asterisk or until the end of the line is 
encountered.

A backslash (\) placed directly in front of a question mark or asterisk cancels their special 
meaning



Search Conditions

Select "OR" if you want to find a match if any of the search patterns are on a line from a file.

Select "AND" if you want to find a match only if all the search patters are on a line from a 
file.



Found Text Window

Enter here the number of lines before and after the line with the found text to display.



Files With Text Only

Check here if you want only the files (and the lines with the found text) to be displayed.    If 
this is not check, the name of every file searched will be displayed.



Select Directory dialog box

The following dialog box is displayed to allow you to chose another drive and directory to 
search    You can find out more information about each item enclosed in a rectangle of 
dashed lines by clicking with the mouse inside the rectangle.



Current path

This is the drive and directory that will be search if you click the OK button.



Directory List

Double click on an item in the list to select it.    This will change the drive and directory that 
will be searched.



Window

Cascade 
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1, 2, ... Command 



Cascade

Use this command to arrange multiple opened windows in an overlapped fashion. 



Tile

Use this command to arrange multiple opened windows in a non-overlapped fashion.



Arrange Icons

Use this command to arrange the icons for minimized windows at the bottom of the main 
window.    If there is an open test document window at the bottom of the main window, then 
some or all of the icons may not be visible because they will be underneath this test window.



1, 2, ... Command

The text search program displays a list of currently open windows at the bottom of the 
Window menu.    A check mark appears in front of the active window.    Choose a window from
this list to make it the active window.



Help

Contents 
Using Help 

Context Help Command 

About Search Text 



Contents

Use this command to display the opening screen of Help.    From the opening screen, you can
jump to step-by-step instructions for using the text search program and various types of 
reference information.

Once you open Help, you can click the Contents button whenever you want to return to the 
opening screen.



Using Help

Use this command for instructions about using Help.



Context Help Command

Use the Context Help command to obtain help on some portion of the text search program.    
When you choose the Toolbar's Context Help button, the mouse pointer will change to an 
arrow and question mark.    Then click somewhere in the text search program window, such 
as another Toolbar button.    The Help topic will be shown for the item you clicked.

Shortcut
Keys: SHIFT+F1



About Search Text

Use this command to display the copyright notice and version number of your copy of the 
text search program.

More Information gives some additional information about the text search program.



More Information

Please send any comments or suggestions to:

Excellco, Inc.
1960 Eva Drive
Lansdale, PA    19446

Phones:
voice: (215) 699-4021
Fax: (215) 699-2288



Support/Customer Service

Registered users are entitled to priority support.    We can be reached at:

Excellco, Inc.
1960 Eva Drive
Lansdale, PA    19446

Phones:
voice: (215) 699-4021
Fax: (215) 699-2288

CompuServe: 103216,2107

 




